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Chapter 1

Introduction

This tutorial describes how to use ISim Hardware Co-Simulation (HWCoSim) to
accelerate the simulation of Floating Point Unit (FPU) Fast Fourier Transform (FFT) and
verify the FFT implementation on a Kintex™-7 KC705 board.

Digital Signal Processing (DSP) designs are typically very time-consuming to simulate in
software due to their data and computation intensiveness.

* A fast, bit-accurate model is often used to speed up the simulation of a DSP function,
but it does not provide any cycle accuracy and is not straightforward to integrate
with other Register Transfer Level (RTL) modules.

* A behavioral RTL model provides bit-and-cycle accuracy but it is relatively slower
to simulate. A structural Register Transfer Level (RTL) or gate-level model is even
much slower to simulate.

* Sometimes an IP does not provide a fast, bit-accurate model or even a behavioral
RTL model, which leaves the slowest structural/gate-level simulation as the only
choice.

ISim hardware co-simulation provides an additional means to simulate DSP functions
by off loading intensive computations to FPGA. It can bring synthesizable HDL code,
synthesized or protected netlists such as IP cores generated by CORE Generator™
software into FPGA for co-simulation. That solves the problem of getting bit-and-cycle
accurate simulation models as well as bolstering the simulation performance. For many
complex DSP designs, not only does it accelerate the simulation of a design, it verifies
the implementation of the design on actual hardware. ISim hardware co-simulation
complements RTL, post-synthesis, and post-implementation simulation to complete
the verification tool suite.

Prerequisites

¢ ISE Design Suite version 14.1 or above
e Kintex™-7 FPGA KC705 Evaluation Kit
e Tutorial Files: kc705_fp_fft hwCoSim_tutorial.zip

Accelerating Floating Point FFT Simulation
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Tutorial Files

File Description

fp_fft_top.v Wrapper that instantiates the floating point FFT core.

fp_fft_tb.vhd Top-level VHDL test bench that generates test vectors to exercise
the FFT core.

isim_run.tcl Custom simulation command file that measures the ISim
simulation time.

custom_wave_config.tcl Custom waveform configuration file.

fp_fft_tb.prj ISim project file for the command line flow.

full_compile.bat Windows batch file to fully compile the design for hardware
co-simulation with the Fuse command line.

full_compile.sh Linux shell script to fully compile the design for hardware
co-simulation with the Fuse command line.

incr_compile.bat Windows batch file to incrementally compile the test bench for
hardware co-simulation with the Fuse command line.

incr_compile.sh Linux shell script to incrementally compile the test bench for
hardware co-simulation with the Fuse command line.

run_isim.bat Windows batch file to launch the ISim simulation.

run_isim.sh Linux shell script to launch the ISim simulation.

Note When performing this tutorial, all data files must be copied to your current
working directory.
Accelerating Floating Point FFT Simulation
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Chapter 2

Tutorial

This tutorial describes how to use ISim Hardware Co-simulation to accelerate the
simulation of Floating Point Unit (PFU) Fast Fourier Transform (FFT) and verify the FFT
implementation on a Xilinx® KC705 board.

This tutorial has four sections with the steps you need to run an FFT design through
ISim hardware co-simulation. Perform the steps in the order that they are presented.
These sections are as follows:

1. Generating a FFT Core in CORE Generator™

2. Creating a Test Bench

3. Compiling the Design for Hardware Co-Simulation
4

Running ISim Hardware Co-Simulation

Step 1. Generating a FFT Core in CORE Generator

In this tutorial, you use the Fast Fourier Transform (FFT) IP core generated from CORE
Generator™ tool and create an ISim Hardware Co-Simulation (HWCoSim) test bench
that runs on the Kintex™-7 FPGA KC705 Evaluation Kit.

Note The screen shots captured in this tutorial are based on the Fast Fourier Transform
version 8.0. The CORE Generator GUI might look different in later versions of the tool.

1. Launch the ISE® Design Suite Project Navigator.

2. Select File > New Project to open the New Project Wizard. Enter a project name
(FloatingPointFFT ) and location. Click Next.

Accelerating Floating Point FFT Simulation
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& Mew Project Wizard

Create New Project

Specify project location and type.
Enter a name, locations, and comment for the project
MName: FloatingPointFFT

Location: C:\Tuterials\DSP FloatingPointFFT

@

Working Directory: | C:VTutorials\DSP \FloatingPointFFT

Description:

Select the type of topdevel source for the project

Top-evel source type:

HOL [+]

ot ] [

3. On the Project Settings page:

® Choose Evaluation Development Board as KC705 board, which is a Kintex-7
KC705 Evaluation Platform.

* Ensure the following default value settings:
— Family: Kintex7
- Device: XC7K325T
— Package: FFG900
— Speed: -1
* Ensure the following HDL source-specific settings:
—  Synthesis Tool: XST (VHDL/Verilog)
— Simulator: ISim (VHDL/Verilog)
— Preferred Language: Verilog

* In the Project Summary page, ensure all project settings are correct and click
Finish to complete the project creation

Accelerating Floating Point FFT Simulation
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Project Settings

Spedfy device and project properties.

Select the device and design flow for the project

| Property MName Value

immlw Kintex-7 KCT05 Evaluation Platform -
Product Category All -
Family Kintex7? -
Device ACTK325T ~I N
Package FFG300 =N
Speed -1 -
Toep-Level Source Type HDL -
Synthesis Tool K5T (WHDL/Verilog) -
Simulator 15im (VHDL/ Verilog) -
Preferred Language Verilog -
Property Specification in Project File | Store all values -

Manual Compile Order
VHDL Source Analysis Standard |VHDL-93 [+]
Enable Meszage Filtering Iﬂ

) e

4. Choose Project > New Source to open the New Source Wizard. Select IP (CORE
Generator & Architecture Wizard) and name the IP as fp_fft_core . Click Next.

(=]

& MNew Source Wizard

Select Source Type

Select source type, file name and its location.
o IP (CORE Generator & Architecture Wizard)
[D] Schematic

User Document

Verilog Module

wt] Verilog Test Fixture

'] VHDL Module

[ VHDL Library

[F] VHDL Package

] VHDL Test Bench

E Embedded Processor

File name:

| fp_fft_core |

Location:

| C: {Tuterials\DSP \FloatingPointFFT Ypcore_dir | [;]

Add to project

e

J [ concel ]

5. From Select IP Wizard, choose Fast Fourier Transform 8.0 under Digital Signal
Processing -> Transforms -> FFTs. Click Next, and then click Finish.

Accelerating Floating Point FFT Simulation
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Select IP

Create Coregen or Architecture Wizard IP Core.

View by Function View by Name

Mame “ Duplicates Version AXM AXM-Stream AXMA-Lite Status
Ellffr Communication 8 Metworking
: E} |~ Telecommunications
& ‘Q’ LTE Fast Fourier Transform 1.0
7 Wireless
‘Q’ LTE Fast Fourier Transform 1.0
|7 Digital Signal Processing
= |7 Transforms
B[ FFTs
. Fast Fourier Transform 71
Fast Fourier Transform
LTE Fast Fourier Transform

Pre-Production

!
Pre-Production @

Pre-Production
Pre-Production
Pre-Production

AXM-Stream

License Vendor

Li

Search IP Catalog: | Fast Fourier Transform

[ All TP versions

Only IP compatible with ch

[nee J[

6. When the FFT core GUI opens, set the Transform Length to 16384and click Next.

Y Fast Fourier Transform
Documents  View
IP Symbol

logiC P Fast Fourier Transform

xilime. com:ip: xfft: 8.0

Component Name [ffr,core

Channels Transform Length

\he - ;
T A 16384 %

m_axis_staius_iraia]oo]

s_ais_ooniig_mam{L5:0]

5 axis_corfig_tvalid

5_axis_config_treary . )
Implementation Options

Target Clock Frequency Range: 1..550 MHz

@ Automatically Select

Target Data Throughput Range: 1..550 MSPS

) Pipelined, Streaming 1/0

5_axis_data_idaim[3L0] m_axis_daia_frata[31.1]

5_axis_dam_tvalid m_axis_dat_user[o:]
s_xis_dam_tlasr m_axis_dam_tvalid
5_axis_dam_tready m_axis_dam_tlast

m_axis_daia_tready

) Radix-4, Burst /O
) Radix-2, Burst I/O

aclk

("1 Radix-2 Lite, Burst [/O

aresein evert_frame_siarted

aclken evert_tlast_unexpeded

Transform Length Options
evert_tlast_missing
yevart_tt overilon [ Run Time Configurable Transform Length
evert_data_in_channel_halt
even_dalus_channe|_halt

event_data_nut_channel_halt

P Symbul‘ “} Implementation Details] 4 Latency J %] € Models <Back  Pagelof3 [ Next > H Generate ” Cancel H

Help

7. Set the Data Format to Floating Point, and the Output Ordering to Natural Order.
Click Next.
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4] Fast Fourier Transform
Documents  View

1P Symbol & X

_axis_config_tdata[15:0]

=_axis_config_tvalid

=_axis_config_tready

s_axis_data_tdata{83:0]
_ads_data_tvalid
5_sxis_data_tlast
=_axis_data_tready

event_status_channel_hait

event_data_out_channel_hait

< [ ] v

% 1P symbol |*§; Implementation Details | % Latency | % € Models

logiC{PE
Data Format
() Fixed Point
Precision Options

Input Data Width |32 ~

Phase Factor Width

Scaling Options
Unscaled
@ Scaled

Block Floating Point

Control Signals
[] ACLKEN
[] ARESETn (active low)

ARESETn must be asserted for a minimum of 2
cycles

Optional Output Fields

Fast Fourier Transform

(== =]

ilinx.com:ip:xfft:8.0

@ Floating Point

Rounding Modes
@ Truncation
Convergent Rounding
Output Ordering
) Bit/Digit Reversed Order

@ Matural Order

Cydlic Prefix Insertion

Throttle Schemes

[F] XK_INDEX ) Real Time
[F] ovFLO @ Non Real Time
I < Back IPagean3[ Next > ”Generate“ Cancel H Help

Choose Use 3-multiplier structure (resource optimization) for the Complex
Multipliers option. Click Generate to generate the core.

L] Fast Fourier Transform

Documents View
IP Symbol =

5_aunis_sonlig_tdaia[L5.0]

s_atis_conig_tvalid

= axis_corfig_tready

s_avis_dam_datafsao] m_ais_dar warafs3io]
5_axis_daa_valid m_axis_dam_misrfoc]
5_axis_dam_tlast m_axis_data_tvalid
=_axis_dam_tready: m_axis_data,_tiast

m_axis_dam tready

event_frame_started
avent_tlast_unexpeced
event_tlast_missing
»avent_ft_overilo
event_dam_in_channe|_halt
event_sans_channel_falt

event_dat_mit_shannel_halt

g P Svmboll J Implementation Detai15| 4 Latency J %/ CModels

logic ¥ Fast Fourier Transform . .ieso
Memory Options
Data Phase Factors
@ Block RAM @ Block RAM

O Distributed RAM

O Distributed RAM

Number Of Stages Using Block RAM Reorder Buffer

0 =

@ Block RAM

) Distributed RAM

Hybrid Memories

Optimize Block RAM Count Using Hybrid Memories

QOptimize Options
Complex Multipliers

' Use CLE logic

® Use 3-multiplier structure (resource optimization)

() Use 4-multiplier structure (performance optimization)

Butterfly Arithmetic
@ Use CLB logic
() Use XtremeDSP Slices

l Generate H Cancel H Help

After the CORE Generator finishes successfully, Add a top-level module,

fp_fft_top

, that instantiates the generated fp_fft_core

IP core. This is required

because ISim hardware co-simulation only supports a Hardware Description
Language (HDL) top-level module. You can use the completed fp_fft_top.v
provided in this tutorial. Choose Project > Add Source > fp_£ft_top.v, select Open

and then click OK.

Accelerating Floating Point FFT Simulation
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Step 2: Creating a Test Bench

1.

2.
3.

Add a VHDL test bench module fp_fft_tb that generates test vectors to exercise
the fp_fft_top instance. You can use the completed fp_fft_tb.vhd file
provided in this tutorial.

Select Project > Add Source > fp_fft_tb.vhd.
Click Open, and then click OK.

The VHDL test bench has a constant IP_DATA which is an array of depth 16384 of
records T_IP_SAMPLE for storing the 32-bit real and imaginary components of the FFT
input. When the simulation starts, the test bench generates the FFT input vector using
create_ip_table function, for the first frame.

The operations performed by the demonstration test bench are appropriate for the
configuration of the generated core, and are a subset of the following operations:

Frame 1: Drive a frame of pre-generated input data from the constant array
IP_DATA.

Frame 2: Configure an inverse transform; drive the output of Frame 1 as a frame
of input data.

Configure Frame 3: A forward transform while the previous transform is running.

Frame 3: Drive the output of Frame 2 as a frame of input data; de-assert AXI TVALID
(and TREADY f present) signals occasionally to demonstrate AXI handshaking

Frames 4-7: Run these frames back-to-back, as quickly as possible:

- Queue up configurations for a forward transform (Frame 4) followed by a
reverse transform (Frame 5), both with a smaller point size (if the point size is
configurable) and a short cyclic prefix (if available).

—  Frame 4: Drive a frame of pre-generated input data.

— Frame 5: Drive the output of Frame 1 as a frame of input data; simultaneously
configure Frame 6: A forward transform with maximum point size, a longer
cyclic prefix (if available) and a zero scaling schedule (if fixed scaling is used).

— Frame 6: Drive a frame of pre-generated input data; simultaneously configure
Frame 7: An inverse transform with maximum point size, no cyclic prefix and
default scaling schedule (if fixed scaling is used)

— Frame 7: drive the output of frame 1 as a frame of input data.

Wait until all frames are complete.

12
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Step 3: Compiling the Design for Hardware Co-Simulation

After you create the test bench, you can compile the design for hardware co-simulation
using the ISim compiler. This can be done in Project Navigator by enabling hardware

co-simulation on a selected instance in your design. The selected instance, including its
sub-modules, are co-simulated in hardware during the ISim simulation. Other modules

are simulated in software.

1. In Project Navigator, switch to the Simulation View. From the Hierarchy Pane,
right-click the fp_fft_top instance, and click Source Properties.

L& ISE Project Navigater (P.7) - CAU \gPaintFFT\FloatingPointFFT.xdse - [Design Summary] Lo =
z ¥ I i H =g
RECEIRFE X|oa| - xR R85 BETIS AR P L9
[Design « 0 8 x| | Design Overview - T
[ [ vew: © [ irpmentzton © B smuaten Sl —
[E € ° o) [} 0B Properties Project File: ‘Flnahngpuimfﬂ'x\se ‘Pzrjzr Errors: No Errors
<) |Behavioral =] © = s
g |Eenavara [ Module Level Utilization Module Name: |o_ffe_core | implementation state: New
[y @] | [ Timing Constraints = = = -
(5] FlostingPointFFT €f =12 Source Properties - Hardware Co-Simulation Praperties ) —
5 £ xcTk325t-1fg900 a3 e
B fft_core - tb (tb_fft_corevhd uting Results:
= * *‘d”u'f_m(m;e tj:;;:m)m 4| e Use this to change the selected design unit's Hardware Co-Simulation propertes. et
o~ e i - % S L ——— iming Constraints:
X7 ft_core - fit_core (fit core] 3 Design View o e e rer stsl
I Hardware C " inal Timing Score:
3 Include File References Property Name Value
G Enable Hardware Co-Simulation =
T 5 Clock Port [top_acik =
o Processes Runring 3 Warni Inf
Target Board for Hardware Co-Simulation | KC705 (TAG) =1 S o
! | Processes: dut - fft_core_top
Enable Incremental Implementation =
@ FF  1Sim Simulstor
A

[ stert|® pesgn [ Fies [ IR Uiraries|

el
—

Console =N

) INFO:HUCoSim - Extracting hardware

[ INFO:HUCoSim - Synthesizing design)

) INFO: HWCoSim - Merging design undei
) INFO:HWCoSim - Synthesizing hardwal [
) INFO:HWCoSim - Implementing hardwal

) INFO:HWCoSim - Checking BAR report
[ INFO:HWCoSim - Exporting hardware co-simulation bitstream and project files

o« [ camcel [ mpy ][ rep

Finished HDL wrapper and bitstream generation process.

Fuse Memory Usage: 163604 KB

Fuse CPU Usage: 42603 ms

Launching ISim simulation engine GUI...

"C:/Users/ksubram/FloatingPointFFT/th_fft_core_isim beh.exe" -intstyle ise —gui -tclbatch isim.cmd -wdb "C:/Users/ksubram/FloatingPointFFI/th_fft_core_isim beh.wdb"
ISim simulation engine GUI launched successfully

Process "Simulate Behavioral Model" completed successfully

< i

[g Console |@ Emors | I\ Warnings | lgh Findin Fikes Results

Edit the properties for the highlighted source

2. In the Source Properties dialog box, do the following;:
¢ Select the Hardware Co-Simulation category.
® Check the Enable Hardware Co-Simulation check box.
e Set the Clock Port to top_aclk.
¢ Select KC705 (JTAG) as the target board.

e Leave the Enable Incremental Implementation option unchecked, and Click
OK.

Note The enabled instance for hardware co-simulation is now marked with a
special icon.

Accelerating Floating Point FFT Simulation
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a.
b.

You can use the Enable Incremental Implementation option after the design

is compiled for hardware co-simulation. If the instance selected for hardware
co-simulation does not change in subsequent runs, you can turn on this option
to skip the synthesis, implementation, and bitstream generation for hardware
co-simulation. It allows the test bench or any portion simulated in software to be
modified and simulated again quickly.

From the Hierarchy Pane, select the fp_fft_tb

instance.

In the Process Pane, right-click Simulate Behavioral Model and click Process

Properties.

0N

&

Browse and add isim_run.tcl

Check the Use Custom Simulation Command File check box.
as the runtime tcl command file.

Disable the Run for Specific Time option.

display level to Advanced, and click OK.

e. Review the values, and click OK.

In the Process Properties > ISim Properties dialog box, change the Property

« i

L ISE Project Navigator (P.7) - CAl g fingPointFFT.xise - [Design Summany] lo|&@]|
z y I Lays =]
0 2 0 * 2@ M@ AR [apre—— = o
DEEI| %% X|oa| » B X BRI =8 PR pZL| @
DEsi?n o085 X ‘v‘ B DES\E C;Z:r”\:‘:\l: = th_fft_e e
[ | views © £} implementation © & smuaton — ALY, | o o 3 -
[ : 1 ) L) 108 Properties Project File: FlostingPointFFT, xise Parser Errors: No Errors
</ |Behavioral - o 4 5 ~
&l ® ID Module Level Utilzation Module Name: _ft_core Implementation State: New
. 2, ] Timing Constraints
Iy | Hisrarchy = S E ‘Jp Target Device: %cTk325t- 1Ffga00 «Errors:
| - & FloatingPointFFT o 03 Pinout Report E
| B 8 a0 [) Clock Report |7 ||| Product Version: 1SE 14,1 *Warnings:
E & [l th_fft_core - th (tb_fft_corevhd) ﬂ Rl ;a\\‘f Timing Design Goak Balanced * Routing Results:
g = . £} Errors and Wamnings
= & % "fﬂ“t(‘:‘r‘e—f‘;&'e—z:’:&%‘:;i 38 B prrradeoe | | |pesion strategy: X Defauit (urlocked) +Timing Constraints:
2 - & - - z
@ B8 Process Properties - [Sim Properties — e friming Score:
¢ |<L I B
g Switch Name Property Name Value [=]
| 22 Mo Processes Running Use Custem Simulation Command File  [¢] Warnings Infos
| processes: th_fftcore - to Custom Simulation Command File C:\Users\ksubram\FloatingPointFFT\isim_run.tcl &
7 : th_fft_ =
%6 % SmSmustor -incremental  Incremental Compilation @
= 82  Behavioral Check Syntax -nedebug Compile for HDL Debugging =
e Simulate Behavioral Model Use Custom Project File B
= -pri Custom Project Filename
Run for Specified Time
Simulation Run Time 1000 ns
Waveform Database Filename C:\Users\ ksubram\FloatingPointFFT\tb_fft_core isim_beh.wdb (=)
Use Custem Waveform Configuration File [] R
& Strt \ B3 Design \‘L‘] Fies I'E Libraries| Custom Waveform Cenfiguration File
e 1 Other Compiler Options 1 =0,
1) INFO:HWCoSim - Exctracting hardwd Value Range Check (=]
1) INFO:HWCoSim - Synthesizing desd Library for Verilog Sources
Jp INEO:HWCoSim - Merging design uffll |.i Specify Search Directories for Include ([
;;Eig:i:: B i‘;‘;::ﬁ:g e | NI Specify define Macro Name and Value
{+ INFO:HWCoSim - Checking EAR rep Specify Top Level Instance Names work.tb_fft_core
) INFO:HWCoSim - Exporting hardwag Load glbl ]
Finished HDL wrapper and bitscrd Other Simulator Commands
Fuse Memory Usage: 163604 KB
Fuse CPU Usage: 42603 ms
SN Property display level; |Advanced [ ] Displey switch names | Default
"C:/Users/ksubram/FloatingPointh iBointFFT/tb_fft_core isim beh.wdb"
15im simulacion engine GUI laun ok [ concel |[ ey |[ b |
Process "Simulate Behavioral

[& console | @ E [\ Warnings |28 Findiin Fies Results |

fp_fft_th

Edit the properties for the highlighted process

In the Process Pane, run the Simulate Behavioral Model process for the dut -
instance.

14

www.Xilinx.com

Accelerating Floating Point FFT Simulation
UG817 (v 14.3) October 16, 2012



& XILINXs

Chapter 2: Tutorial

Compiling the Design on the Command Line

You can invoke the ISim compiler through the Fuse command line tool. You must
provide a project file, the design top level module(s), and other optional arguments such
as libraries and library search path to which to link. To compile the design for hardware
co-simulation, you must also provide the following arguments:

fuse -prj <project file> <top-level modules>

-hwcosim_instance <instance>
-hwcosim_clock <clock>
-hwcosim_board  <board>

-hwcosim_constraints <constraints file>
-hwcosim_incremental [0]1]
-hwcosim_instance  : Specifies the full hierarchical path of the instance to

co-simulate.
-hwcosim_clock : Specifies the port name of the clock input for the instance.
—  This is the clock in the lock-step portion, that is to be controlled by the test bench.

—  For a design with multiple clocks, specify the fastest clock using this option so
that ISim can optimize the simulation. Other clock ports are treated as regular
data ports.

-hwcosim_board : Specifies the identifier of the hardware board to use for
co-simulation.

-hwcosim_constraints (optional): Specifies the custom constraints file that
provides additional constraints for implementing the instance for hardware
co-simulation. We also use the constraints file to specify which ports of the instance
are mapped to external I/Os or clocks.

-hwcosim_incremental (optional): Specifies whether Fuse should reuse the last
generated hardware co-simulation bitstream and skip the implementation flow.

For example, to compile the FFT design for this tutorial, you can run the Fuse command
line as follows:

fuse -prj fp_fft_tb.prj fp_fft_tb

-0 fp_fft_tb.exe

-hwcosim_instance [fp_fft_tb/dut
-hwcosim_clock top_aclk
-hwcosim_board  kc705-jtag
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& XILINXs

Step 4: Running I1Sim Hardware Co-Simulation

The simulation executable generated by the compiler runs in the same way in both
software simulation and hardware co-simulation flow. Project Navigator automatically
launches the simulation executable in GUI mode after the compilation finishes.

In the Instances and Processes Pane, the instance selected for hardware co-simulation is

indicated with a special icon

to see its internal signals and sub-modules.

8. As the instance runs in hardware, you cannot expand it

Before the simulation starts, ISim programs the FPGA with the bitstream file generated

for hardware

co-simulation.

Notice the message in the ISim console window:

“Downloading

bitstream, please

wait

till

After the FPGA is configured, the console shows:

“Bitstream

download

is complete.

READY for

status

is READY”

simulation.”

Note If your computer has more than one Ethernet port, you must identify the one to
use to the simulation process. See Determining the Ethernet Port, for more information.

From this point, you can run the simulation and interact with the ISim GUI the same
way you do in the software simulation flow.

fl 15im (P.7) - [Defaultwefg?] o —

[ File Edit View Smulstion Window Layout Help
o2
Instences en... # O & X/ [Objects

GHE]-@ 55| Simulation Objects for dut
- IR «

| " o o @
+0O8 X

@ v X [roos[e] 6z 1I

| [ Resaunc |

| InstanceandProcess + | = =
@ toitcore I Object Name Value = config_tdatal15:0] 01p110
dut tap_aclk o config_tualid 7
(5 :clock_gen Ui} top_s_axis_co.. o configtready — 7] —
(4 wdata_stim| | | @
(7 :config_sti I}
(& srecord_
(& seheck_ou 1§ top_s_axis_co.. 1
(& 692 | 1§ top_s_axis_da... 1
(3 693 | 1k topm_axis d.. @ E
(A 596 | 1§ top_m_axis_d. o
(G we97 | 1§ top_event 1
(& 699 | 1L top_event
(& 700 11§ top_event 1
M‘J 703 | {5 top_event_:
i 704 Ly top_event_
MJ 706 | [ top_event_
I B4 top_s_axis_co.. 01010101
s =l g top_s_axis_da.. 11000101 7 - ol b . >
— = top_m_axis_d.. 01000101 7 -
| & tnstanc i E[i4 SRR " = Defoult.wcfg® [}
Console o008
[3E 0 ps: Note: Bitstream downioad & complete, READY for smulation,
| b _fit_corejcuty).
| Fiished aircuit intalization process,
at 160 ns: Note: Driving frame: 1 (/tb_fft_core/).
Isim>
Frunal
at 1638560 ns: Note: Waiting for m_axis_data_tiast.......... (ftb_fft_core)).
at 7738960 ns: Note: Frame 2:Waiting for do_config DOME......... (ftb_fft_core;
775560 Nt 0N it Y Uy i L U ot oo (th_fft_core).
at 9437660 ns: Note: Waiting for m_axis_data_tlss _fft_core/)
2 e ciigires R e P haie Jm,fft,cnre/)‘ <:IS""“'E“°” SoeNicees

at 18071360 ns: Note: Waiting for m_axis_data_tvaiid

at 22593350 ns(1): Note: Waiting for m_axis_data_tiast .,
at 24781460 ns: Note: Frame <:Waiting for do_config DONE
at 24781760 ns: Note: Frame 5: Waiting for do_config DONE...

{/tb_fft_corey).

‘at 24732060 ns: Note: Driving the 1st data frame. Uﬂ: # core))
at 26420460 ns: Note: Driving the 2nd data frame.. _core/).
at 34217960 ns: Note: Driving the 3rd data frame. - core|).
at 42016260 ns: Note: Driving the 4th data frame.... (/tb_fft_c nref)
at 436144550 ns: Note: Waiting unil = the output data from al frames...

.. (ftb_fft_core).

== FaiurezNot a real fallre. Simulation finished successfuly.
| User(VHDL) Code Called Simulation Stop _

B consdle |[=] Compiatonlog | @ Breakpoints | [ FindinFilesResuits | [gy SearchResults

Sim Time: 55,976,750,000
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Appendix A

Additional Resources

e Xilinx Glossary -
http://www.xilinx.com/support/documentation/sw_manuals/glossary.htm

¢ Xilinx Documentation - http://www.xilinx.com/support/documentation

¢ Xilinx Support -http://www.xilinx.com/support

e 7 Series User Guides

e Sim User Guide (UG660)
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http://www.xilinx.com/support/documentation/7_series_user_guides.htm
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=14.1;t=ise+tutorials;d=ug660.pdf
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Appendix B

Determining the Ethernet Port

To run an Ethernet-based Hardware Co-Simulation (HWCoSim) when multiple
Ethernet interfaces are present, you must select the Ethernet interface that you want
to co-simulate.

If you ran a previous hardware co-simulation using the Point-to-Point interface option,
you see the following error message:

"ERROR: In process wrapper AHIL_INITIALIZE

Failed to open hardware co-simulation instance.
Error in Point-to-point Ethernet  Hardware Co-simulation.
There are multiple Ethernet interfaces available.

Please select an interface."

Accelerating Floating Point FFT Simulation
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Use the following steps to determine the Ethernet port, set and verify the Ethernet
address, and verify that the simulation runs. Refer to the following figure for Step 1.

‘ CAWMNDOWS sy tem 3 2 \omd. oxe = |O] X

EOVAY « = = o = = = &= = =

1. Determine the Ethernet port to which the co-simulation board is connected.
a. On your system command prompt, open a command terminal window (cmd)

b. In the command window, type ipconfig  -all  to list all Ethernet ports and
connections.

c. Locate the physical address of the Ethernet port connected to the co-simulation
board.

d. Convert the physical address delimiter from a dash (-) to a colon (:). For
example: 00:19:B9:75:E5:95

2. Set and verify the correct Ethernet port in ISim, as follows:
a. Open the ISim GUL
b. Select the Design under Test (DUT).
c.  Go to the Tcl console.
d. In the Tcl console, enter the following commands:

i.  Set the Ethernet address:

hwcosim set ethernetinterfacelD
<t L HHE L > <physical address>

ii. Verify the Ethernet address:
hwcosim get ethernetinterfacelD
iii. Verify that the simulation runs:
run 10us

The following figure outlines the process within the ISim GUL
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